The designations employed and the presentation of material in this information product do not imply the expression of any opinion whatsoever on the part of the Food and Agriculture Organization of the United Nations (FAO) concerning the legal or development status of any country, territory, city or area or of its authorities, or concerning the delimitation of its frontiers or boundaries. The mention of specific companies or products of manufacturers, whether or not these have been patented, does not imply that these have been endorsed or recommended by FAO in preference to others of a similar nature that are not mentioned. The views expressed in this information product are those of the author(s) and do not necessarily reflect the views or policies of FAO.
CONTENTS

1. FAOSTYLE FOR ENGLISH 2017 .......................................................... 3
   1.1 About FAOSTYLE .............................................................................. 3
   1.2 Updated English FAOSTYLE ............................................................ 3
   1.3 Who should use FAOSTYLE? .......................................................... 3
   1.4 Contact ............................................................................................ 3

2. SPELLING AND PUNCTUATION .................................................. 4
   2.1 Spelling and readability ................................................................. 4
   2.2 Punctuation .................................................................................... 4

3. TERMINOLOGY AND NAMES ...................................................... 7
   3.1 Terminology ..................................................................................... 7
   3.2 Names ............................................................................................ 7
   3.3 Foreign languages .......................................................................... 9
   3.4 Language resources ....................................................................... 10
   3.5 Gender-neutral language ................................................................ 10

4. LISTS .......................................................................................... 10

5. ABBREVIATIONS AND ACRONYMS ......................................... 11

6. CAPITALIZATION .......................................................................... 12

7. ITALICS ....................................................................................... 13

8. NUMBERS, UNITS, TIME AND DATES ................................... 14
   8.1 Numbers ........................................................................................ 14
   8.2 Units ............................................................................................. 15
   8.3 Percentages ................................................................................... 15
   8.4 Dates ............................................................................................. 15
   8.5 Time ............................................................................................... 16
   8.6 Currencies ...................................................................................... 16
   8.7 Mathematics and equations ......................................................... 16

9. QUOTATIONS ................................................................................. 17

10. CITATIONS AND REFERENCING STYLE IN FAO PUBLICATIONS ......... 17
   10.1 General indications ...................................................................... 17
   10.2 Reference lists and bibliographies ............................................... 18
   10.3 Examples of bibliographic style .................................................. 21

ANNEX 1 INSTALLING REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE .................................................. 27
“I think the following rules will cover most cases:

i. Never use a metaphor, simile, or other figure of speech which you are used to seeing in print.

ii. Never use a long word where a short one will do.

iii. If it is possible to cut a word out, always cut it out.

iv. Never use the passive where you can use the active.

v. Never use a foreign phrase, a scientific word, or a jargon word if you can think of an everyday English equivalent.

vi. Break any of these rules sooner than say anything outright barbarous.”

George Orwell, Politics and the English Language
1. **FAOSTYLE FOR ENGLISH 2017**

1.1 ___ ABOUT FAOSTYLE

The objective in having a house style is to ensure clarity and consistency across all FAO publications. Therefore, the rules and conventions specified in FAOSTYLE must be applied in all FAO publications.

FAO provides editorial style guides in its six official languages (Arabic, Chinese, English, French, Russian and Spanish) to ensure consistency and quality across its information products. The Library and Publications Branch (OCCP), with the support of the Meeting Programming and Documentation Service (CPAM), reviews the guides periodically to reflect developments in general usage, editorial conventions, translation, publishing practices and editing tools.

The editorial style guides cover matters such as punctuation, units, spelling and citations. Common issues are explained in all languages, but each version of FAOSTYLE also covers problems specific to the language concerned.

The guides serve as a reference for all FAO information products, including public information materials, as well as for correspondence.

1.2 ___ UPDATED ENGLISH FAOSTYLE

This updated version of FAOSTYLE for English is intentionally brief and limited in scope. The overall aim is to simplify some aspects of the writing/editing process that until now have required a disproportionate amount of time, e.g. following idiosyncratic spelling rules, and having to generate reference entries in a form that does not facilitate the use of reference management software. Re the latter, this guide presents an FAO bibliographic style in Citation Style Language (CSL) for use with Mendeley and Zotero.

For more complete coverage of aspects of publications (e.g. content development, writing, editing, graphic design and marketing), please refer to Publishing at FAO – strategy and guidance (forthcoming).

For other editing issues not addressed in this FAOSTYLE or Publishing at FAO, please refer to the *Oxford English Dictionary*, the *Chicago Manual of Style*, and the *United Nations Editorial Manual*.

1.3 ___ WHO SHOULD USE FAOSTYLE?

All FAO staff, consultants and contractors involved in writing, reviewing, editing, translating or proofreading FAO texts and information products should refer to FAOSTYLE. Use of FAOSTYLE should be included in the terms of reference (TOR) for all authoring, translation, editorial and proofreading contracts.

1.4 ___ CONTACT

If you have any comments or queries, please contact PWS-support@fao.org

---

1 This link works for staff at FAO headquarters in Rome. Those working in decentralized offices can access the site via the [FAO Secure Access Gateway](http://secure.fao.org).
2. SPELLING AND PUNCTUATION

2.1 SPELLING AND READABILITY
For spelling and usage, follow the first spelling listed in the latest online edition of the Oxford English Dictionary. The FAO Recommended Word List is discontinued.

Aim for consistency. Where alternative spellings and terms are available, ensure that the usage is consistent within a work. Pay particular attention to this issue in multi-authored texts.

When using word processing software, e.g. Microsoft Word, ensure that the default language for your document is set to English (United Kingdom) by selecting Review – Language – Set Proofing Language in the toolbar.

Remember: computer spellcheckers are a useful tool but not sufficient by themselves.

Reading aloud a printed copy of your document is a good way to spot spelling, punctuation and grammar errors. This technique can also improve its readability. If you run out of breath or have difficulty reading a sentence, then it is probably too long or complex. Remember that English will not be the first language for many readers. Sentences of more than 20 words are difficult for many people, so be concise, also to facilitate scan reading online.

You can also check the readability of your document by using the Flesch Reading Ease and Flesch–Kincaid Grade Level tools available in Word [Options – Proofing – Show Readability Statistics].

2.2 PUNCTUATION
Punctuation is important because it can help improve clarity and readability. The following is a brief clarification of FAO usage with regard to commas, full stops, etc. For other punctuation matters, follow the indications in the online version of the Chicago Manual of Style.

— Commas
Do not use a comma:

• after i.e. and e.g.
• before opening parentheses.

Do not use a comma before and in short lists, e.g. sheep, goats and oxen. However, a comma may be used in lists to avoid ambiguity, e.g. The unit was responsible for overall management, research and development, and marketing, or where a sentence comprises a complex series of phrases, e.g. Ensure that the participants receive the training material in advance, have time to prepare their responses, and have access to relevant resources.

— Full stops
Use full stops:

• with a.m., p.m., e.g. and i.e.
• in abbreviations such as ed., et al., Inc., No., p., pp., Vol.
Do not use full stops:
- after people’s titles and qualifications, e.g. Mr, Mrs, Ms, Dr, MSc and PhD
- in initialisms and acronyms, e.g. FAO, ILO, GDP
- after abbreviations of units of measurement, e.g. 12 kg, 30 m
- after a heading or figure, table and box titles
- in contractions, where the last letter is the same as that of the original word, e.g. Ltd (Limited), as well as plural contractions, e.g. eds (editors), vols (volumes)
- after website addresses.

— En-dashes

An en-dash (–) is longer than a hyphen (−) and can be used either in pairs to set off an element that is not part of the main sentence, or alone to add a phrase elaborating on what has gone before.

FAO does not use the em-dash (—).

To obtain the correct en-dash, press CTRL+MINUS on the numeric keypad (or ALT+MINUS on Macintosh) or select the en-dash from under Insert – Symbol. Do not use double hyphens to denote an en-dash.

Paired, parenthetical dashes have a space on either side: e.g. Poverty in rural areas – home to 94 percent of the poor – has been reduced at a slower rate. They should not be overused (only once per paragraph).

An unspaced en-dash is used between words of equal weight (Paris–Rome flight) and for relationships (pupil–teacher ratio) when the first part of a compound does not modify the second part.

- pp. 1–20 (range of values)
- cost–benefit analysis
- dose–response curve
- rice–fish farming
- South–South cooperation
- see also Section 8.4 Dates

Do not use the en-dash to denote a range of values or dates with the constructions from … to or between … and, e.g. from 1970 to 1987, not from 1970–1987.

— Hyphens

For general usage, consult the Hyphens section in the Oxford English Dictionary (OED) Online. Also useful is a ten-page hyphenation guide (available as a PDF) in The Chicago Manual of Style Online section 7.85 (available as a PDF at www.chicagomanualofstyle.org/16/images/ch07_tab01.pdf).
Notes and examples:

- Turn off the automatic hyphenation function. In Word 2013, select Page Layout, Hyphenation, None. (Note: At layout stage, you may need to adjust the automatic hyphenation setting in InDesign, especially for pages with several columns of text.)
- For nouns, use the first spelling given in the OED Online, e.g. cooperation rather than co-operation.
- Use a non-breaking space (Alt/Ctrl+Shift+Space) or a non-breaking hyphen (Alt/Ctrl+Shift+Minus) to avoid ending a line of text with a hyphen.
- With proper nouns, use upper case for all principal hyphenated words, e.g. European Commission for the Control of Foot-and-Mouth Disease.
- Never use hyphens to break names of people or places at the end of the page or anywhere in the text unless if the hyphen is part of the name, e.g. Victoria not Victoria.
- Never use two hyphens together, instead use the en-dash.
- Many compound adjectives should be hyphenated, e.g. sugar-free, results-driven, cost-effective.
- Use of well: the problem was well known, but a well-known problem.
- Plan for the long term, but long-term planning.
- No hyphen after “-ly”: a radically changed situation.
- Use hyphens for clarity when describing ages, numbers and lengths of time. Compare: 15-year-old fish (fish that are 15 years old) with 15 year-old fish (15 fish that are all one year old).
- A USD 5000-investment; a three-year plan.
- Separate a prefix from a date, e.g. pre-2000.
- Numeric plurals in a list, e.g. two-, three- or fourfold.
- No hyphen in phrasal verbs: food reserves began to build up.
- Director-General; Assistant Director-General.

Position of note numbers

For footnotes and endnotes, use sequential numbering and not other characters or symbols. The note numbering is one sequence for the entire main text (not by chapter). Begin numbering again for each annex/appendix. The note number (in superscript) should be placed at the end of the sentence after the terminal punctuation.

- This is an example.¹

Where used within a sentence, it should go at the end of the clause after the punctuation.

- The process failed to respect the standard procedure,² which explains the extreme values.

The general rule is to place the note number after punctuation. The exception is with an en-dash, where the number comes after the word before the en-dash³ – as shown here.
3. TERMINOLOGY AND NAMES

3.1 TERMINOLOGY

— Terminological resources
The TERM PORTAL has been created to store, manage and update concepts, terms and definitions related to the various topics of FAO (agricultural sciences, nutrition, biotechnology, fisheries, forestry, food security, to name a few) in all FAO official languages (plus Italian and Latin for taxonomies). Among the various collections, it includes FAOTERM, which is the oldest terminological collection, and the FAO Structure and the Names of Countries database (NOCS).

For guidance on UN terminology and other aspects of style, refer to the United Nations Editorial Manual.

— Basic information about FAO
The full title of FAO is the Food and Agriculture Organization of the United Nations (FAO). The abbreviated form is FAO, not preceded by “the” and without dots (not F.A.O.), e.g. in 1951, FAO moved its headquarters to Rome.

Note that the acronym FAO, when used, is placed at the end of the full name, not after Organization. Other common mistakes to avoid are the substitution of Agricultural and Organisation. The abbreviation of the full title to FAO of the UN is tolerated for some media purposes, but should otherwise be avoided. Only when referring to FAO should the word organization take a capital letter, e.g. the Organization has regional offices around the globe.

Write an FAO regulation (not a FAO ...).

The FAO Conference, after it has been mentioned in full, may subsequently be referred to as the Conference (with a capital letter).

FAO headquarters does not take a capital h. Do not use the initialism HQ.

3.2 NAMES

— Country names and other toponyms
FAO has 197 Members comprising 194 Member Nations, one Member Organization (European Union) and two Associate Members (Faroe Islands and Tokelau). Use the FAO Names of Countries database (NOCS) to check names of countries and territories. The database stores also the currencies and the country codes. The designations used in the system are based on UN practice and may differ from popular use.

It is important to use the correct names for countries. For most purposes and publications, use the “short” name as shown in NOCS, even though this may sometimes appear long to you. The NOCS “full” names tend to be used in very formal documents such as agreements and at official ceremonies.
Names in NOCS are updated as necessary, for example, most recently:

- 20 February 2017, Change of name: The long name of the former Islamic Republic of the Gambia has changed back to the Republic of the Gambia since 17 February 2017. The short name does not change.
- 30 August 2016, Czechia: The short name of the Czech Republic has changed from 17 May 2016.

Use **TERM PORTAL** for abbreviations and acronyms, as well as for names of organizations and specific technical terms.

Pay attention to sensitive political issues. Use caution statements and **FAO’s standard disclaimers**.

Maps may be controversial and must be checked carefully before publication. Ensure any names are correct (for country names, check NOCS). Do not simply reproduce maps provided by other sources. Various countries may have unresolved or competing claims on land and maritime areas. Consult the **UN Cartographic Database**.

---

**Official names of countries and organizations**

Countries such as **the Netherlands** and **the United States of America** are collective singular nouns and thus always take singular verbs.

Country names should be fully spelled out when used in the noun form: **the United States of America**. ISO country codes should only be used to abbreviate countries in figures: **USA**.

Particular attention should be made to the following countries for which the designation must be carefully followed:

<table>
<thead>
<tr>
<th>FULL NAME</th>
<th>SHORT NAME</th>
<th>SHORT NAME FOR LISTS AND TABLES</th>
</tr>
</thead>
<tbody>
<tr>
<td>the Plurinational State of Bolivia</td>
<td>Bolivia (Plurinational State of)</td>
<td>Bolivia (Plurinational State of)</td>
</tr>
<tr>
<td>the Republic of the Congo</td>
<td>the Congo</td>
<td>Congo</td>
</tr>
<tr>
<td>the Democratic Republic of the Congo</td>
<td>the Democratic Republic of the Congo</td>
<td>Democratic Republic of the Congo</td>
</tr>
<tr>
<td>the Islamic Republic of Iran</td>
<td>Iran (Islamic Republic of)</td>
<td>Iran (Islamic Republic of)</td>
</tr>
<tr>
<td>The former Yugoslav Republic of Macedonia</td>
<td>The former Yugoslav Republic of Macedonia</td>
<td>The former Yugoslav Republic of Macedonia</td>
</tr>
<tr>
<td>the United Arab Emirates</td>
<td>the United Arab Emirates</td>
<td>United Arab Emirates</td>
</tr>
<tr>
<td>the United Republic of Tanzania</td>
<td>the United Republic of Tanzania</td>
<td>United Republic of Tanzania</td>
</tr>
<tr>
<td>the United States of America</td>
<td>the United States of America</td>
<td>United States of America</td>
</tr>
<tr>
<td>the Bolivarian Republic of Venezuela</td>
<td>Venezuela (Bolivarian Republic of)</td>
<td>Venezuela (Bolivarian Republic of)</td>
</tr>
</tbody>
</table>

The European Union (Member Organization) is a Member of FAO. Where it is included in discourse, as it is not a nation, country or state, it is more correct to speak of FAO Members (with a capital M) rather than Member Nations, Member Countries or Member States. In NOCS, the full and short forms, also for tables, are the same: European Union (Member Organization). Hence, in text, refer to it as the European Union (Member Organization). Do not abbreviate it to the EU in text, although expressions such as EU28
and EU25 are acceptable in text and tables if their meaning is clarified. Instead of EU legislation, prefer legislation of the European Union.

The Holy See, not the Vatican, has Permanent Observer status at FAO.

Use Near East rather than Middle East unless the latter is specifically required.

— Titles and proper names
Follow individuals’ expressed preference on how to mention their names. As the surname is the first element in certain nationalities’ names, the order should not be inverted. Note that Spanish and Portuguese names often include two surnames.

It is generally not necessary to use honorifics or titles, such as Mr, Mrs, Ms, Sir, Professor and Dr. In general, people should be referred to by their names, not their titles.

Alphabetization of names (for reference sections and indexes):

- **Chinese and Vietnamese names**: alphabetize according to the first (family) name, e.g. Kim Thanh, C.
- **Arabic names**: the particles Al and El are not taken into account when ordering reference lists and indexes, e.g. Al-Hamadan is listed under H and not under A.
- **Burmese names**: move the honorific (U, Naw, Saw) to the end before alphabetizing.
- **Spanish surnames**: where there are two surnames, alphabetize according to the first surname (e.g. Ángel Martinez Espinosa is listed under Martinez Espinosa).
- **Portuguese names**: where there are two or more surnames, the entry is usually alphabetized according to the last surname. Words like Filho, Junior, Neto, Netto, Sobrinho are treated as part of the last surname: Paulino Ricardo do Rosario Gomes Filho is indexed as Gomes Filho. Note: José Graziano da Silva is listed under G.
- The particles van, de, etc. are taken into account for the alphabetical ordering of the list, e.g. de María is listed under D and not under M.

— Scientific names
Use italics (see also Section 7. Italics) to indicate genera, species and subspecies [e.g. Oryza sativa, Cucurbita spp.], but not for higher levels of taxonomic classification [e.g. Brassicaceae]. Note that modifiers to species’ names [e.g. cv., var., spp.] and species authorities [e.g. Rubus L.] are not italicized.

Besides TERM PORTAL, see also the International Plant Protection Convention style guide.

### 3.3 FOREIGN LANGUAGES

— **Foreign words and phrases**
Foreign words and phrases that have become anglicized should be in normal font (not italicized), e.g. ad hoc, a priori, de facto, de jure [see also Section 7. Italics].

Avoid giving a quote or word directly in a foreign language. If it is absolutely necessary, make sure it is clear, and provide a translation in parentheses.
Use official translations of titles of publications, major events, organizations and so on. Where no official translation exists, a translation may be made.

When reproducing foreign words, include the diacritical marks that are placed above or beneath certain letters and which change their sound.

— Foreign titles and proper names
Foreign proper nouns, people’s names and the names of currencies are not italicized.

— Transliteration
Only translate and transliterate Cyrillic, Arabic, Chinese or other scripts into Latin characters when no official translation exists.

3.4 LANGUAGE RESOURCES
Besides TERM PORTAL, the following language resources and links are provided as a support to all those who are involved in the research of language equivalents and validation of terms and titles for authoring, translating, revising and editing information products:

• **AGROVOC** – The FAO Thesaurus serves as a controlled vocabulary for the indexing of publications in agricultural science and technology.

• **FAO Biotechnology Glossary**

• **IATE** – The terminology database of the European Union

• **UNTERM** – The United Nations terminology database

• **International Plant Protection Convention style guide**.

3.5 GENDER-NEUTRAL LANGUAGE
FAO seeks to use gender-neutral language. For example, rather than fishermen, use fishers (like farmers); prefer chairperson or chair to chairman; prefer humanity or humankind to mankind; prefer human-induced or caused by humans to man-made; prefer labour, personnel and workforce to manpower.

4. LISTS
Lists are generally punctuated in the same way as sentences, with semicolons or full stops at the end of each item in the list. No punctuation is necessary in lists with very short entries.

Available audiovisual equipment includes:

• radios

• televisions

• cameras.

When list entries are complex but not complete sentences, use initial lowercase letters at the start of the phrase and end each with a semicolon, except for the final entry, which ends with a full stop.
The process will consist of:

- extensive beta testing followed by a review process;
- re-engineering of the software based on pilot-group feedback and peer review; and
- a second phase of testing followed by final modifications, approval and rollout.

When entries consist of complete sentences, begin each with a capital letter and end each with a full stop.

- The necessary equipment should be requested from suppliers.
- All staff should provide a budget code for each request.
- All equipment should be accounted for.

Use numbered lists when a specific sequence is dictated, to facilitate subsequent cross-referencing, e.g. see point 12, or because the preceding text makes specific mention of a ranking or number of entries, e.g. There are 15 reasons why you should offer your support.

Be consistent throughout the document. Use the same types of bullet points and the same numerical and letter series for the same levels of information. Do not mix numbers and bullets in sublists.

Unless they need to appear in a ranking or chronological sequence, country names should be given in alphabetical order in text, lists and figures.

5. ABBREVIATIONS AND ACRONYMS

Abbreviations (short forms of words, e.g. Mrs, Dr, Vol.) and acronyms/initialisms (initial letters of words, e.g. GDP) should be used where they improve readability, but do not litter the text with them.

In documents intended for external target audiences, do not use acronyms that are only used within the Organization, e.g. for divisions, offices and units.

Use the TERM PORTAL to check acronyms or refer to an original source if the acronym is not included there.

Acronyms should always be defined in full the first time they are used in a document: e.g. the World Health Organization (WHO). They may then be used alone, e.g. According to a WHO spokesperson ...

If parts of a publication are likely to be read separately (such as front matter and body text, or independent chapters), consider spelling out the acronym upon first mention in each of the parts concerned.

Avoid the use of acronyms in the titles and level headings of publications.

Acronyms and initialisms do not take full stops (e.g. FAO, not F.A.O.); most abbreviations do (e.g. min.), with the exception of units of measurement (kg, ml) and contractions. See also Section 2.2 Full stops.

Avoid overuse of the abbreviations e.g., i.e. and etc. in the main text. These can be replaced with that is, in other words, for example, such as and so on. They are acceptable, however, in footnotes, parentheses, lists, tables, boxes and figures.
Do not abbreviate the names of countries in text, e.g. exports to the United Kingdom of Great Britain and Northern Ireland, not ... to the UK; and exports to the United States of America, not ... to the USA (see Section 3.2 Names). In these two cases, however, acronyms may be used in references (see Section 10. Bibliographic style and references).

Do not begin a sentence with an abbreviation, initialism or acronym. FAO is an exception. If you use numerous abbreviations or acronyms, list these in a separate section (Abbreviations and Acronyms) in the front matter (generally, after Acknowledgements), capitalizing proper nouns but not common nouns (e.g. GDP – gross domestic product, not Gross Domestic Product).

6. CAPITALIZATION

Avoid excessive use of capital letters in text. It is not usually necessary to capitalize common nouns (non-proper nouns). For example, rather than the Manager and 20 Officers, write the manager and 20 officers.

Titles and headings have specific rules:

- In headings, subheadings, captions and book titles, use capitals only for the initial letter of the phrase and any proper nouns (names of persons, places, organizations, languages, nationalities). If the title is based on a conference/workshop whose title was capitalized, then the new title will need to retain the capitalization.
- Capitalize the initial letter of the first word and major words of series titles, including journal titles.

Capitals are used to distinguish the specific from the generic:

- Use capital letters when naming a specific body, e.g. The Government of France ruled that, but not in general references, e.g. All participating governments were asked to comment on the ruling.
- Organizations, committees, universities, laws, treaties, and so on take initial capitals when the full title is given. However, when used alone, the word organization takes a capital letter only when referring to FAO.
- Geographical and political designations, as well as official titles, take initial capitals for specific titles, but not when the term is generic.
- The word “state” takes a lower-case initial when referring generally to the institution or to nations or divisions of a nation; it takes a capital S when a specific state is named, e.g. State of Andhra Pradesh, but state-owned enterprise, head of state.
- Use initial capitals for historical eras and events (the First World War), declarations and conventions when the full title is given.
- Names of stars and planets (e.g. the Sun, the Earth, etc.) should be capitalized if treated as proper nouns. Where earth is used to refer to ground or soil, the word is not capitalized.
- Names of the seasons are not capitalized. Note that seasons should not generally be used to specify dates, as they vary according to the hemisphere, although exceptions may be made, e.g. for training materials aimed at a specific country/region. As a season, use autumn not fall.
- Initial capitals should be used for brand or trade names if the original is capitalized.
6. CAPITALIZATION

For regions, capitalize when part of a proper name or political grouping, e.g. the representatives of Southeast Asia, the Near East and Eastern Europe, but not for a generic geographical grouping, e.g. a species common across eastern Europe.

Names of indigenous peoples and ethnic and national groups take an initial capital, and they are not italicized, e.g. the San people.

Adjectives associated with these names are also capitalized. In proper nouns, use capital letters for all principal hyphenated words, e.g. European Commission for the Control of Foot-and-Mouth Disease. Do not capitalize, however, where a hyphen is part of a prefixed word. Note that sub-Saharan Africa does not take an initial capital.

When referring to specific tabular or graphic elements in a text, use a capital letter for tables and figures, e.g. see Table 1.3. When referring to more than one tabular or graphic element, give each its full title: e.g. As shown in Figure 2 and Figure 3. Note that capitals are not used when the term is used in a general sense, e.g. see the table above.

The first word after a colon should be capitalized only if it is a proper noun or introduces a sentence.

7. ITALICS

Italic font is used for:

- emphasis, as sparingly as possible (when the body text is in italic, roman type should be used for emphasis);
- all book and journal titles (titles of chapters and articles are not italicized); titles of paintings and sculptures; plays, films and radio and television programmes; and names of ships (prefixes such as SS or HMS are not italicized);
- mathematical variables;
- some foreign words and phrases use italics, others do not, for example:

<table>
<thead>
<tr>
<th>ITALICIZED</th>
<th>NOT ITALICIZED</th>
</tr>
</thead>
<tbody>
<tr>
<td>et al.</td>
<td>addendum</td>
</tr>
<tr>
<td>et seq.</td>
<td>ad hoc</td>
</tr>
<tr>
<td>ex ante</td>
<td>ad lib</td>
</tr>
<tr>
<td>ex post</td>
<td>de facto</td>
</tr>
<tr>
<td>ex situ</td>
<td>e.g.</td>
</tr>
<tr>
<td>in situ</td>
<td>etc.</td>
</tr>
<tr>
<td>in vitro</td>
<td>ibid.</td>
</tr>
<tr>
<td>in vivo</td>
<td>i.e.</td>
</tr>
<tr>
<td>inter alia</td>
<td>status quo</td>
</tr>
<tr>
<td>laissez-passant</td>
<td>versus</td>
</tr>
<tr>
<td>per se</td>
<td>vs</td>
</tr>
<tr>
<td>vis-à-vis</td>
<td>vice versa</td>
</tr>
</tbody>
</table>
• the names of parties in legal cases: e.g. State of Wyoming v. Jameson;
• to indicate genera, species and subspecies.

Do not italicize text between quotation marks, unless part of the original quotation.

8. NUMBERS, UNITS, TIME AND DATES

8.1 NUMBERS
Always use Arabic numerals for dates, times, percentages, units of money or measurement, ages, page references, ratios and scales.

Numbers from one to ten inclusive are always written in text as words, whereas numbers 11 and upwards are written as numerals, with the following exceptions:

• Spell out any number above ten that begins a sentence, e.g. Fifteen NGOs were present.
• Use numerals where a number accompanies a unit, e.g. 5 cm, 7 percent, USD 2.
• Use numerals when numbers from both groups are used consecutively, e.g. The number of replies varied, ranging between 2 and 12 per group.

For decimals:
• Use a point (a full stop, not a comma), e.g. 14.36.
• Use a zero before the decimal point for numbers smaller than 1, e.g. 0.23.
• Use the plural for any decimal number above 1.0, e.g. 1.5.

For large values:
• Use spaces, not full stops or commas, to denote thousands, etc. [e.g. 2 500; 10 000] in main text and tables. Use hard [non-breaking] spaces to avoid awkward number divisions at the end of lines (press CTRL+SHIFT+SPACEBAR, or ALT+SHIFT+SPACEBAR for Macintosh). Do not use spaces for years (e.g. 2007) or page numbers (e.g. p. 1402).
• For millions, use numerals separated by non-breaking spaces [e.g. 150 324 399] unless the last six numerals are zeroes, in which case express these digits as million (e.g. 150 000 000 should be written as 150 million). The same principle holds for billions, trillions, etc. Note: data are in general reported to three significant figures.
• FAO uses the short scale for billions and trillions: 1 billion = a thousand million or 1 000 000 000 (10^9); 1 trillion = a million or 1 000 000 000 000 (10^12), etc. Be aware of similar terms in other languages, such as milliard (10^9) used in French or millón (10^6) used in Spanish.

Write fractions in words rather than numbers: e.g. one-third.

Avoid the use of roman numerals except in established terminology (e.g. Type II error).
Where possible, write out ordinal numbers in full, e.g. the Thirteenth Session of the FAO Committee on Fisheries. Where it is necessary to use numerals, do not use superscript for the ordinal indicator, e.g. the 13th Session not the 13th Session.

Avoid the use of adverbial ordinal numbers (firstly, secondly, thirdly, etc.), as subsequent numbers sound awkward. Replace these with first, second, third, etc.

For telephone and fax numbers, be consistent in the use of parentheses or spaces. The recommended style is: (+39) 06 57057051.

To refer to a specific page: p. 40. To refer to a range: pp. 40–42. To refer to the total number of pages in a publication: 120 pp.

8.2 UNITS
Use the International System of Units (SI) – tonnes, hectares, etc., with equivalents in parentheses if necessary.

Do not use punctuation or letter spacing in such measurements as cm, mm, g, ha, °C. Note, however, that there should always be a non-breaking space between the number and the unit, e.g. 3 cm, 70 g, 37 °C.

Do not use the plural for symbols/abbreviations of units [e.g. 7 kg, not 7 kgs].
To indicate “per”, use / as in 3 m/s (rather than 3 m s\(^{-1}\)).

Avoid combinations of three units of the type: Production is 25 tonnes/ha/year. Prefer: Annual production is 25 tonnes/ha.

Do not abbreviate the words litre and tonne. In general, use tonnes, not tons or metric tonnes. Check with originators if unsure whether they mean tons (imperial) or tonnes (metric). For shipping, use tons.

Always give temperature in Celsius not Fahrenheit, e.g. 35.5 °C.

In series of units, consistently use the symbol: 10 cm, 20 cm and 50 cm, not 10, 20 and 50 cm.

8.3 PERCENTAGES
Use percent [never per cent] rather than the symbol “%” in text, e.g. Exports increased by 16 percent in the last quarter. In tables and figures, use the symbol with no space between the number and the symbol, e.g. 16%.

8.4 DATES
Write dates in this order: Monday, 16 October 2000 (with no comma between the month and the year).

Do not use ordinal numbers such as 3rd, 4th, 5th for dates [e.g. 1 January, not 1st January].

Avoid starting a sentence with a year [or other figure], but if unavoidable it must be spelled out: Nineteen ninety-eight was not a leap year.

Do not use apostrophes in decades: e.g. 1990s.
Do not abbreviate years, i.e. use 1990, not ’90. Decades are referred to in numerals (e.g. the 1990s, not the nineties and not the 90s).

A range of dates is normally indicated thus: e.g. 2015–2025 or from 2015 to 2025. This implies the whole period from the beginning of 2015 to the end of 2025 inclusive, whereas 2015/16 implies one crop or fiscal year of 12 months starting in 2015 and ending in 2016. Note that, when used in tables, three-year averages may take a hyphen to denote the three-year period and an en-dash between the two sets, e.g. 1997-99–2015-16.

Centuries should be written out in full, e.g. the twenty-first century not the 21st century.

Where necessary to avoid confusion, use BCE (before Common Era) or CE (Common Era) for dates, placing the abbreviation after the year (e.g. 1000 BCE).

8.5 TIME
The use of the 24-hour system is preferred, e.g. 08.00 hours, 13.30 hours. When it is necessary to use the 12-hour system, use full stops as follows: e.g. 8 a.m., 1.30 p.m. Be consistent.

Use a non-breaking space between the number and the unit [press CTRL+SHIFT+SPACEBAR, or ALT+SHIFT+SPACEBAR for Macintosh].

8.6 CURRENCIES
Rather than the currency symbol (which sometimes fails to convert in other software programs), use the ISO Currency Code as given in NOCS, with a non-breaking space between the abbreviation and the amount, e.g. USD 700 000 rather than US$700,000 and EUR 800 000 rather than €800,000.

To facilitate comparison of amounts in different currencies within a text, try to give an indicative equivalent in USD, or provide an exchange rate (either in a footnote or at the end of the list of abbreviations and acronyms). The exchange rate equivalent should be that valid at the date of the values rather than the current one.

8.7 MATHEMATICS AND EQUATIONS
Relational and operational signs should have a space either side of them (e.g. 3 + 2 = 5).

Use the multiplication sign × (found in Word under Insert – Symbol) not lower-case letter x.

Use Word Equation Editor to set out equations.

Symbols used for variables, including Greek characters, should be italicized.

In chemical formulae, use subscript (indicating molecules), reduced font below the line: CO₂. Only use CO2 where it is impossible to use a subscript. (Superscript indicates atomic charge, as in Ba²⁺.)
9. QUOTATIONS

Use Harvard style.

For words or short sentences, use quotation marks:

McKinsey and Company (2009) state that “in forestry and agriculture, both costs and investments are relatively low.”

Use double quotation marks for the whole quote, and single quotation marks for a quote or highlight within the main quote. For examples, Baresi (1998) reports that “farmers complain about ‘unofficial’ agents.”

For paragraphs (or any text of more than 30 words or two lines), use block quotations. These are introduced by a colon and indented in the following line, set in a smaller font size to differentiate them from main text.

As stated in the document:

Ensuring food security and nutrition at the household and global levels, requires investing in nutrition-sensitive agriculture, protecting women’s rights and improving their social and nutritional status (FAO, 2011, p. 3).

10. CITATIONS AND REFERENCING STYLE IN FAO PUBLICATIONS

10.1 GENERAL INDICATIONS

In the front matter (usually on the same page as the Abstract, sometimes on the Disclaimer page, sometimes on the back cover), all books produced by FAO should include their proper citation – author, year, full title and subtitle (in italics), series, place of publication, publisher and number of pages (total including preliminary pages). It is not necessary to provide such a citation on non-book products.

Many FAO publications will have FAO as the author. However, depending on the category of publication and in line with the indications of the FAO Corporate Publishing Policy and Publishing at FAO – Strategy and Guidance, authorship of the publication may be attributed to FAO or to individual authors, as is the case with many regular and high-profile publications.

For in-text references, FAO uses an author-date style – name of author followed by year of publication of the work cited, e.g. Costa and Gilles, 2016. To insert in-text references, originators can also use the online FAO bibliographic style in Citation Style Language (CSL) for use with Mendeley and Zotero (see Section 10.2 Reference lists and bibliographies).

It is not necessary to indicate the page number(s) unless the text is quoted.

Avoid the use of abbreviations such as op. cit., loc., cit., ibid., cf. in footnotes or endnotes. Any such information should be converted to full entries in the References or Bibliography section and the appropriate footnote marker replaced with an entry, e.g. Smith, 1997.
Do not use the ampersand character (&) for in-text references, so not Jackson & Schmidt but Jackson and Schmidt.

Where there are more than three authors, abbreviate to *et al.* for the in-text reference, e.g. Walls et al., 2009). See also Section 10.2 Reference lists and bibliographies for guidance on citation of authors’ names in reference lists.

In-text references should be presented as follows:

- one work, one author:
  ... as demonstrated by Sanders (2008) ...
  ... as it has been demonstrated (Sanders, 2008) ...

- one work, up to three authors:
  ... according to a recent report (Sanders, Cohen and Bolbol, 2010) ...

- one work, more than three authors:
  ... as stated in a recent survey (Sanders *et al.*, 2011) ...

- more than one work by different authors:
  ... as various studies demonstrate (Sanders, 2008; Murguía, 2010) ...
  ... as various studies demonstrate (Sanders, 2008; Murguía, 2010; Bekele *et al.*, 2007) ...

- more than one work by the same author:
  (Sanders, 2009a, 2009b)

- different authors with the same surname:
  (Sanders, J., 2009; Sanders, B., 1999)

- edited works:
  (Sanders, ed., 2008)
  according to Sanders (ed., 2008)

- indirect reference (secondary source); when referring to a source cited within another source, refer to the one you consulted, not the original:
  as demonstrated by Sanders (cited in Murguía, 2008).

Note that personal communications are not cited in the bibliography, only in the text, e.g. (J. Wright, personal communication, 2000).

For works published by FAO, check the title page for authors’ names. Any named authors can be cited as such. If there are no named authors, it is a corporate work and FAO should be cited as the author. For more on whether to attribute publications to individual authors or FAO, see Publishing at FAO Section 1.11.

### 10.2 REFERENCE LISTS AND BIBLIOGRAPHIES

#### Citations

Many FAO publications include in-text references with a section called References or Bibliography listing all works cited. This section is placed at the end of the main text (and before the annexes).
Proper referencing is important for the credibility of FAO publications and for avoiding accusations of plagiarism. It is a standard part of originators’ work. However, attempting to comply with style-guide recommendations on citations can be difficult and time-consuming.

Points to note
A references section contains all the works cited in the main text. A bibliography may also contain separate additional material used for the writing of the publication, but not directly cited in the text, as well as further reading.

Aim for consistency in the presentation of entries.
All references must be “complete” in the sense that they include at least the minimum information needed to specify the work in question. Typically, for a book, this means as a minimum: name of author(s), year of publication, title, place of publication, publisher and number of pages (including preliminary pages in the total); for an article in a journal: name of author(s), year of publication, title, journal title, volume, issue and pages.

For all reference entries:
- In the case of multiple authors, the names of all authors should usually be given. If the list of authors is unmanageably long, cite only the main authors, followed by et al. FAO follows Chicago style:
  For works by or edited by four to ten persons, all names are usually given in the bibliography. … For works with more than ten authors … only the first seven should be listed in the bibliography, followed by et al.
- Use the ampersand (&) between the names of the last two authors in the bibliography, but use and in the text.
- Entries by the same author/s should be listed in ascending chronological order. Where there are two or more titles by the same author in the same year, distinguish by using a, b, c, etc. as necessary after the year. The lettering is determined by the order in which the works are first cited in the text, the first work mentioned being assigned the letter a, e.g. 2008a.
- Titles of books, journals and periodicals are italicized (do not use inverted commas). Titles of articles and chapters are not italicized.
- Bold should only be used for authors but not for any other element of the reference, Munro. G.R. 2010. From drain to …
- The place (city) of publication comes before the publisher, e.g. Ankara, FAO. When the city is the capital, the country is normally omitted. In reference entries, the United States and United Kingdom may be abbreviated to USA and UK. Omit other geographical or administrative details, i.e. no county/state/province.
- Forthcoming publications, i.e. works that have not yet been published at the time of writing, should be cited as forthcoming, not in press or in preparation. Thus:
  _ in the text: (Brandt, forthcoming)
  _ in the References/Bibliography: Brandt, S. [forthcoming]. Title …
• For all publications where FAO is the author or publisher (with the publication attributed to individual authors, always provide the URL [preferably the short URL]. This aids dissemination of FAO publications.
• For references in a different language, refer to the FAOSTYLE for that language.
• Articles in journals. In a References/Bibliography, choose either to give the full titles of the journals or their abbreviated titles in all entries, not some full and some abbreviated. Abbreviated titles should be in the form of the standard “approved” abbreviation for the journals. There are various lists of such journal abbreviations available online, generally grouped by sector.

Styles, and limitations of the FAO citation style
For publications in English, there is no one global standard style for composing and formatting reference entries. A number of different styles are in use in different sectors of the publishing world, e.g. APA, Chicago, Harvard and MLA. Over the years, like many other organizations, FAO has developed its own bibliographic style. However, this style is different from widely accepted styles, and hence many originators and editors have difficulty in applying it correctly. This has meant FAO has spent a significant amount of time and money on generating, formatting and correcting reference entries. Moreover, the FAO bibliographic style, developed in the age of the typewriter and word processor, does not facilitate the use of today’s standard reference management software.

Manual generation and formatting of citations
If you intend to input reference entries manually, please refer to the tables in Section 10.3 Examples of bibliographic style for examples of how to cite FAO and non-FAO publications.

New option – automatic generation of citations and references/bibliographies
Several bibliographic management software programs facilitate the generation of citations and bibliographic entries, e.g. EndNote, Mendeley, RefWorks and Zotero. Such tools (some open-source) save time and remove much of the drudgery from formatting citations and generating bibliographies.

There is now available online an FAO bibliographic style in Citation Style Language (CSL) for use with Mendeley and Zotero. For guidance on how to install these, please see Annex 1.

As there are various video tutorials available online, even complete beginners can start using these tools within a few minutes to input records manually (completing standard fields such as author, title, year) or automatically (e.g. using metadata from web pages and PDFs). These records can then be downloaded as necessary in the form of reference entries already formatted in FAO bibliographic style. The records will then remain in a master file (or can be grouped in appropriate subfolders) for use in future publications. They can also be exported and shared with other colleagues. In this way, a unit can compile a large master file of citation entries that can be accessed by all users.

In some minor cases, it has been necessary to adapt the FAO bibliographic style to fit the software (e.g. the way URLs are cited). The tables in Section 10.3 Examples of bibliographic style indicate which item type should be selected in Mendeley and Zotero.

2 OCCP is especially grateful to Liu Bin, Nutrition Officer (ES), for creating, testing and amending the CSL version of the FAO citation style.
Please remember that although software tools can capture almost all of the elements required for citations, it may be necessary to make some manual edits. For a type of item not specified in the list, select the type that is most similar and edit as necessary. Moreover, the item types and outputs from Mendeley and Zotero are not identical.

In addition, the FAO Library has licensing arrangements for EndNote, with FAOSTYLE citations. If you prefer to use EndNote, please contact the FAO Library.

### 10.3 EXAMPLES OF BIBLIOGRAPHIC STYLE

#### Table 1. Citation examples for FAO publications and electronic resources

<table>
<thead>
<tr>
<th>FAO PUBLICATIONS – TEMPLATES</th>
<th>ITEM TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ZOTERO</strong></td>
<td><strong>MENDELEY</strong></td>
</tr>
<tr>
<td>FAO as author</td>
<td>Corporate Author. Year of publication. Publication title. Series. Place of publication. Number of pages (total including preliminary pages). (URL [short if available]).</td>
</tr>
<tr>
<td>Other author of FAO publication</td>
<td>Personal Author. Year of publication. Publication title. Series. Place of publication. Publisher. Number of pages (total including preliminary pages). (URL [short if available]).</td>
</tr>
</tbody>
</table>

#### FAO PUBLICATIONS – EXAMPLES

**Where FAO is a co-author**


**Single author**


**2 or 3 authors**


**More than 3 authors**


**Editors**


**Forthcoming, undated and the like**


<table>
<thead>
<tr>
<th>FAO PUBLICATIONS – EXAMPLES</th>
<th>ITEM TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web fact sheet</strong></td>
<td>ZOTERO: Web page</td>
</tr>
<tr>
<td><strong>Monograph (PDF) only available on Web</strong></td>
<td>ZOTERO: Web page</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>ZOTERO: Web page</td>
</tr>
</tbody>
</table>

**10. CITATIONS AND REFERENCING STYLE IN FAO PUBLICATIONS**
Table 2. Citation examples for non-FAO publications and electronic resources

<table>
<thead>
<tr>
<th>NON-FAO PUBLICATIONS – EXAMPLES</th>
<th>ITEM TYPE</th>
<th>ZOTERO</th>
<th>MENDELEY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author with more than one work in the same year, add letters (a, b, c) after year, with first work mentioned in the main text appearing as YYYYa.</strong></td>
<td>World Bank. 2010a. <em>World Development Report 2010. Development and climate change</em>. Washington, DC.</td>
<td>Book</td>
<td>Book</td>
</tr>
</tbody>
</table>
### NON-FAO PUBLICATIONS – EXAMPLES

<table>
<thead>
<tr>
<th>Item Type</th>
<th>ZOTERO</th>
<th>Mendeley</th>
</tr>
</thead>
</table>

### NON-FAO ELECTRONIC RESOURCES

<table>
<thead>
<tr>
<th>Item Type</th>
<th>ZOTERO</th>
<th>Mendeley</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-FAO Publications – Examples</td>
<td>Item Type</td>
<td>Zotero</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>(for audio/video file types, put audio/video in Format field)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(put CD–ROM in System field; put publisher in Company field)</td>
<td></td>
<td>(put CD–ROM in Genre field; put publisher in Publisher field)</td>
</tr>
<tr>
<td>(for audio/video file types, put audio/video in Format field)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>World Health Organization (WHO).</strong> 2017. Rehabilitation: Key for health in the 21st century [video]. [Cited 15 February 2017]. <a href="https://www.youtube.com/watch?v=a8uaRziXruc">https://www.youtube.com/watch?v=a8uaRziXruc</a></td>
<td>Video recording</td>
<td>Film</td>
</tr>
<tr>
<td>(for audio/video file types, put audio/video in Format field)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
ANNEX 1
INSTALLING REFERENCE MANAGEMENT SOFTWARE FOR CITATIONS IN FAO STYLE

All operations described in this annex can be done with normal user rights. No administrator-user rights are required.

HOW TO INSTALL MENDELEY AND ZOTERO

To install Zotero or Mendeley:
1. Open FAO Application Catalog in Internet Explorer. Other browsers are not supported. (If unable to access, download programs from their respective home pages.)
2. Input “Zotero” or “Mendeley” in the search bar in upper right corner. Press Enter.
3. Press the blue “INSTALL” button at lower right part. In the pop-up window, select “YES”.
4. After a while, the software will be installed to the computer. It can be found in Start menu → All Programs.

Note: First-time running of Mendeley requires registration and log in.
To use Zotero and Mendeley to format citations automatically, you also need to install the Word add-in and browser connector. Complete the following steps using Google Chrome.

— For Zotero
  • Word add-in:
    1. Make sure Word is closed. From Zotero’s menu: Tools → Preferences.
    2. Click “Cite” button. Choose “Word Processors” tab.
    3. Click “Install Microsoft Word Add-in” button. After a few seconds, a window will pop out showing “Installation was successful.”
  • Connector for Chrome:
    1. Open this link using Google Chrome.
    2. Click the blue “ADD TO CHROME” button.
    3. Click “Add Extension” button in the pop-out window.

In Word, Zotero appears as a tab between View and Add-ins.

— For Mendeley
  • Word add-in:
    1. Make sure Word and Outlook are closed. From Mendeley’s menu: Tools → Install MS Word Plugin.
    2. A window will pop out showing that the installation is successful and how to check in Word.

1 The mention of specific companies or products of manufacturers, whether or not these have been patented, does not imply that these have been endorsed or recommended by FAO in preference to others of a similar nature that are not mentioned.
Connector for Chrome:
1. From the menu: Tools → Install Web Importer.
2. A web page will appear in browser. Follow the instructions. It’s similar to Zotero.

In Word, Mendeley appears under the References tab as Insert Citation.

HOW TO INSTALL FAO CITATION STYLE FOR MENDELEY AND ZOTERO
Prerequisite: Install Zotero or Mendeley as indicated above.

— In Zotero
1. From the Zotero menu: Tools → Preferences.
2. Click “Cite” button. Choose “Styles” tab.
3. Click “Get additional styles…” link on bottom left of the “Style Manager” frame. It will take you to the Zotero Style Repository.
4. Input “fao” in the search bar.
5. Click the link “Food and Agriculture Organization of the United Nations” to download the style file (.csl). If the link is covered by the preview of the style, just click the first word “Food”.
6. Save the file to hard drive.
7. Go back to Zotero’s Preferences window. Click the “+” button on bottom right of the “Style Manager” frame.
8. Navigate to the folder where the style file is stored and choose the “food-and-agriculture-organization-of-the-united-nations.csl” file. Click Open to install it.

— In Mendeley
1. From the Mendeley menu: View → Citation Style → More Styles…
2. Choose “Get More Styles” tab.
4. Select the style. Click “Install” button on the right.
5. “Food and Agriculture Organization of the United Nations” should appear in the “Installed” tab.

HELP GUIDES AND VIDEO TUTORIALS
For both Zotero and Mendeley, various help guides and video tutorials are available online. For example:

Zotero:
https://www.zotero.org/support/screencast_tutorials
https://www.zotero.org/support/screencast_tutorials/zotero_and_word

Mendeley:
https://www.mendeley.com/guides/desktop
https://www.mendeley.com/guides
The objective in having a house style is to ensure clarity and consistency across all FAO publications. Replacing the 2016 edition, this updated version of FAOSTYLE for English cover matters such as punctuation, units, spelling and citations. Intentionally brief and limited in scope, its aim is provide practical guidance on aspects of the writing and editing process not covered in the recently released document Publishing at FAO – strategy and guidance.

All FAO staff, consultants and contractors involved in writing, reviewing, editing, translating or proofreading FAO texts and information products in English should use this FAOSTYLE in conjunction with Publishing at FAO – strategy and guidance.

**OCCP CONTACTS**

Publishing policy and procedures  
PWS-support@fao.org

Copyright, rights, licensing, FAO logo clearance  
Copyright@fao.org

Clearance/requests letter of agreement (LoA) / memorandum of understanding (MoU) copyright clause  
occp-clearance@fao.org

Marketing, dissemination and sales  
Publications-Sales@fao.org

PWS support and advisory services  
PWS-support@fao.org

Quality assurance, reprints, job numbers, ISBNs, etc.  
Publishing-Submissions@fao.org